Basic Imaging Routines Toolkit

Congratulations on your purchase of the “Basic Imaging Routines Toolkit” from Discount
Document Scanning. The routines in this toolkit will allow you to process an entire directory (or
folder) of images. Each routine can perform a basic imaging function. The images must currently be
of BMP (Windows Bitmap) format and depending on the routine may be one of a Black and White, 8-
bit Grayscale, or 24-bit Colour image.

For those that are using a true MS-DOS operating system, an 8.3 naming convention
(maximum filename length of 8 characters and a maximum extension length of 3 characters) is used.

Routines included in the toolkit are listed in the Table of Contents and explained in the
following pages (one routine description per page). The routine’s parameters are listed one per line
and red in colour and surrounded with angle brackets. The upper right hand corner of each routine
description included a graphical representation of whether the routine works with Source and/or
Destination images and B/W, Grayscale, or Colour images.

When coordinates are required by routines the origin [ 0, 0 ]is located in the upper left hand
corner of the image. The x coordinate increases as you move towards the right of the image and the
y coordinate increases as you move towards the bottom of the image. The bottom right hand corner
of the image is represented by coordinate [ width-1, height-1].

Image representations are as follows:

For Black and White images, black = 1 and white = o.
For Grayscale images, black = 0 and white = 255.

For Colour images, black =[ 0, 0, 0 ] and white =[ 255, 255, 255 ]

For technical support with the use of this Toolkit’s routines can be obtained by emailing your
question to: support@discountdocumentscanning.com
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1. How to Install Software

Download the DEMO version of the software (install.exe) from the website and double click on
(or run) the install.exe program. Specify which folder the software is to be installed to. You can
now run the programs in the toolkit but all images created will display “SAMPLE” across each
image until the software has been activated.

2.How to Activate Software

Run any one of the routines with the “INSTALL” parameter used and an install code will be
returned. Email this “install code” in the Subject line of the email to
activate@discountdocumentscanning.com . You will then be emailed an “Activation code” for

your software/hardware licence. Run any one of the routines of the toolkit with the activation
code as the parameter and all routines will be activated and the “SAMPLE” will not be written to
any of the images created from the toolkit routines.

3.How to Run Software

If your operating system is Windows XP go to the <Start> tab and right-click. Then right-click on
the <run .. .>option. In the text box type “cmd.exe” to open an MS-DOS window. Once the
MS-DOS window has opened the Toolkit’s routines can be used on their own at the command
prompt or as part of a batch file.
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4.Routines

Source or Destination File or Directory names can use either relative or absolute filename or
directory names. Say your current location is c:\images and you want to take the images in the
directory c:\images\source and place the rotated images (90 degrees) in the directory
c:\images\destination . The following commands are equivalent and will all do the same action:

>rotate.exe c:\images\source c:\images\destination 90.0
>rotate.exe source destination 90
>rotate source ..\images\destination 90.00

This flexibility in routine parameter syntax applies to all routines.




B/W Gray

Color

Source

Alt180 Destination

Syntax: Alt180.exe

< Source File or Directory >

< Destination File or Directory >

< 0=Rotate Even ordered images 180° 1=Rotate Odd ordered images 180°>

The order is determined by sorting alphabetically the filenames in the Source Directory.

Purpose: This routine alternates between rotating images 180 degrees and copying the image a
“as is” to the destination directory.

Uses: This routine can be useful when dealing with images that have been scanned using a
scanner with a document feeder where the pages are scanned in Landscape (pages turned on its
side) orientation. This is ideal in a production environment where scanning speed is crucial. If
the scanner can scan 8.5”x11” pages in Landscape orientation then each page represents 8.5”
of scanning rather than 11” (when pages are scanned in normally — Portrait orientation). This
represents an almost 30% increase in throughput by just scanning the pages in on its side. The
effect this has on the orientation of the images is that the pages need to be rotated after being
scanned (270° for first image, 90° for second image, 270° for third image, 90° for fourth image, .
.. ). So to correct the orientations the following two routines would have to be run:

>rotate images\stepl images\step2 90.0
> alt180 images\step2 images\step3 1

Related Routines: Rotate




B/W Gray Color

Source

Destination

Blacklmg

Syntax: Blackimg.exe

< Destination Filename >

< Image Width >

< Image Height >

< Units 0=Pixels 1=Inches 2=Centimetres > Applies to Image Width and Height Parameters
< DPI (Dots Per Inch) >

< Number of Bits 1=Black and White Image 8=Grayscale Image 24=Colour Image >
Purpose: This routine creates an Image that is entirely Black in color.

Uses: This routine can be used to create a black image to be used as background.

Related Routines: Whitelmg




B/W Gray

Color

Source

Destination

ChgBits

Syntax: ChgBits.exe

< Source File or Directory >

< Destination File or Directory >

< Number of Bits for Destination images, 1=Black and White, 8=Grayscale, 24=Colour >

Purpose: This routine changes image(s) from one of Black and White, Grayscale, or Colour to a
different number of bits per pixel . When moving from a lower number of bits/pixel to a higher
number of pixels the image will appear identical but the file will be larger in size. When
changing the number of bits/pixel to a lower value color information is lost and the image
filesize will be reduced as well.

Uses: This routine can be used to make images of different types (B/W, Grayscale, and Colour)
the same type so that they can all be processed in the same way.

Related Routines: SetDPI, Imginfo




B/W Gray Color

Source

Destination

ChgColor

Syntax: ChgColor.exe

< Source File or Directory >

< Destination File or Directory >

< Red Parameter String Low-High/Out Value >

< Green Parameter String Low-High/Out Value >

< Blue Parameter String Low-High/Out Value >

Low Value: Must be a value from 0 to 255 and be less than or equal to High Value.
High Value: Must be a value from 0 to 255 and be greater than or equal to Low Value.

Out Value: Can be one of the following — 1) A fixed value from 0 to 255 2) GF (Greatest
Frequency) surveys entire color space for the greatest frequency of pixels over the image.
Sampling is done at a resolution of 32 (instead of 256) for each of the three colour parameters.
3) An Offset value can be used to shift colours to make image lighter, darker, more red, etc. (ie.
0-ff/+35, 55-100/-40 ). Values that are shifted below 0 are set to 0 and values shifted above
255 are set to 255.

Hex values (base 16) can also be used (must be used for all of Low, High, and Out values) by
specifying an ‘x’ character at the start of the parameter (ie. x0-ff/GF, xAO-FF/FF ).

Syntax for each parameter does not allow for spaces or any other characters

Purpose: This routine modifies colour images based on red, green, and blue parameter strings.
Black and White and Grayscale images are copied to Destination file/directory unchanged.

Uses: This routine can be modify the colour in images to create various effects including using
the GF (Greatest Frequency) to create a consistent background colour. This routine can also be
used to lighten or darken images using an offset for the Out value. Can be used to reduce
redness of older 35mm slides that have been scanned into images.

Related Routines: ChgGray, Colorimg




B/W Gray

Color

Source

Destination

ChgGray

Syntax: ChgGray .exe

< Source File or Directory >

< Destination File or Directory >

< Gray Parameter String Low-High/Out Value >

Low Value: Must be a value from 0 to 255 and be less than or equal to High Value.
High Value: Must be a value from 0 to 255 and be greater than or equal to Low Value.

Out Value: Can be one of the following — 1) A fixed value from 0 to 255 2) GF (Greatest
Frequency) surveys all 256 gray values for the greatest frequency of pixels over the image. 3) An
Offset value can be used to gray value to make image lighter or darker, etc. (ie. 0-ff/+35, 55-
100/-40). Values that are shifted below 0 are set to 0 and values shifted above 255 are set to
255.

Hex values (base 16) can also be used (must be used for all of Low, High, and Out values) by
specifying an ‘x’ character at the start of the parameter (ie. x0-ff/GF, xAO-FF/FF ).

Syntax for each parameter does not allow for spaces or any other characters

Purpose: This routine modifies Gray images with Black and White and Colour images being
copied to Destination file/directory unchanged.

Uses: This routine can be modify the shade of Gray in images to create various effects including
using the GF (Greatest Frequency) to create a consistent background colour. This routine can
also be used to lighten or darken images using an offset for the Out value.

Related Routines: ChgColor, Colorimg




B/W Gray Color

Source

Destination

ColorIimg

Syntax: Colorimg.exe

< Destination File >

< Image Width >

< Image Height >

< Units — 0=Pixels, 1=Inches, 2=Centimetres > Applies to Image Width and Height Parameters
< DPI (Dots Per Inch) >

< Red Value (0 to 255) >

< Green Value (0 to 255) >

< Blue Value (0 to 255) >

Purpose: This routine can be used to create an image with a consistent color.
Uses: This routine can be used for creating a non-white background color.

Related Routines: Blacklmg, Whitelmg, Graylmg




B/W Gray Color

Source

Destination

Croplmg

Syntax: Croplmg.exe

< Source File or Directory >

< Destination File or Directory >

< Amount to Remove from TOP Edge of Image >

< Amount to Remove from BOTTOM Edge of Image >
< Amount to Remove from LEFT Edge of Image >

< Amount to Remove from RIGHT Edge of Image >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >

Purpose: To trim off unwanted amounts from the outside edges of image(s).
Uses: This routine can be used to trim off the edge effects of pages scanned.

Related Routines: Sublmg, Padlmg, DelEdge




B/W Gray Color

Source

Destination

DelEdge

Syntax: DelEdge.exe

< Source File or Directory >

< Destination File or Directory >

< Amount to Remove from TOP Edge of Image >

< Amount to Remove from BOTTOM Edge of Image >
< Amount to Remove from LEFT Edge of Image >

< Amount to Remove from RIGHT Edge of Image >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >

Purpose: To white out unwanted amounts of pixels from the outside edges of image(s). The
original dimensions of the image(s) are not changed.

Uses: This routine can be used to trim off the edge effects of pages scanned.

Related Routines: Sublmg, Padimg, Croplmg




B/W Gray Color

Source

Destination

Graylmg

Syntax: Graylmg.exe

< Destination File >

< Image Width >

< Image Height >

< Units — 0=Pixels, 1=Inches, 2=Centimetres > Applies to Image Width and Height Parameters
< DPI (Dots Per Inch) >

< Gray Value (0 to 255) >

Purpose: This routine can be used to create an image with a consistent gray color.
Uses: This routine can be used for creating a gray background color.

Related Routines: Colorimg, Blacklmg, Whitelmg




B/W Gray

Color
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ImgAND

Syntax: ImgAND.exe
< Source File or Directory >
< Destination File or Directory >

< AND File > This image file is AND’ed with each source file and written to Destination file (or
Directory). The dimensions of the Destination file will be the same as the Source image file. If
the AND file is smaller than the Source file the area not overlapped is not affected. If the AND
file and the Source file have different bit/pixel values the Source file is copied to the Destination
file unaffected.

< X Coordinate > The coordinates represents the offset of the AND image to the Source image.
The origin of the coordinate system (0,0) is located at the upper left-hand corner of the Source
image.

<Y Coordinate > The lower right hand corner represents the coordinates (width-1, height-1). All
coordinates representing pixels of the image have positive X and Y coordinates.

Purpose: This routine will AND two images together.
Uses: This routine can be used to white out given areas of a source image.

Related Routines: ImgOR, ImgXOR




B/W Gray Color

Source

Destination

ImglInfo

Syntax: ImglInfo.exe

< Source File or Directory >

Purpose: This routine lists information about the Source image file (or files in the Source
Directory).

Uses: The following information is listed:
Width of Image (in Pixels/Inches/Centimetres)
Height of Image (in Pixels/Inches/Centimetres)
Type: (one of B/W, Gray, or Colour)
Image Bits/Pixel: (one of 1, 8, or 24)
Image Size (in Bytes)
File Size (in Bytes)
X DPI (Dots Per Inch)
Y DPI (Dots Per Inch)

Related Routines:




B/W Gray

Color
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Destination

ImgOR

Syntax: ImgOR.exe
< Source File or Directory >
< Destination File or Directory >

< OR File > This image file is OR’ed with each source file and written to Destination file (or
Directory). The dimensions of the Destination file will be the same as the Source image file. If
the OR file is smaller than the Source file the area not overlapped is not affected. If the OR file
and the Source file have different bit/pixel values the Source file is copied to the Destination file
unaffected.

< X Coordinate > The coordinates represents the offset of the OR image to the Source image.
The origin of the coordinate system (0,0) is located at the upper left-hand corner of the Source
image.

<Y Coordinate > The lower right hand corner represents the coordinates (width-1, height-1). All
coordinates representing pixels of the image have positive X and Y coordinates.

Purpose: This routine will OR two images together.
Uses: This routine can be used to black out given areas of a source image.

Related Routines: ImgAND, ImgXOR




B/W Gray

Color

Source

Destination

ImgXOR

Syntax: ImgXOR.exe
< Source File or Directory >
< Destination File or Directory >

< XOR File > This image file is XOR’ed with each source file and written to Destination file (or
Directory). The dimensions of the Destination file will be the same as the Source image file. If
the XOR file is smaller than the Source file the area not overlapped is not affected. If the XOR
file and the Source file have different bit/pixel values the Source file is copied to the Destination
file unaffected.

< X Coordinate > The coordinates represents the offset of the XOR image to the Source image.
The origin of the coordinate system (0,0) is located at the upper left-hand corner of the Source
image.

<Y Coordinate > The lower right hand corner represents the coordinates (width-1, height-1). All
coordinates representing pixels of the image have positive X and Y coordinates.

Purpose: This routine will XOR two images together.

Uses: This routine can be used to add black text to an image with other text in the Source
image.

Related Routines: ImgAND, ImgOR




B/W Gray Color

Source

Destination

MakeDir

Syntax: MakeDir.exe

< Destination Directory >

< Root Folder Name>

< Number of Counter Digits >
< Counter Start Value >

< Number of Folders >

< Counter Increment >

Purpose: This routine creates multiple folder numbered for easy organizing of image files.

Uses: This routine can be used to scan in similar but different groups of images. For example,
folders labelled: book01, book02, book03, . .. can be used to organize images (one per page)
into these folders (each one representing a different book).

Related Routines:




B/W Gray Color

Source

Destination

Mirror

Syntax: Mirror.exe
< Source File or Directory >
< Destination File or Directory >

< Flip Axis — 0=Flip Horizontally, 1=Flip Vertically >

Purpose: This routine takes a Source Image or images from the Source Directory and flips each
image either horizontally or vertically.

Uses: Various visual effects in images are possible.

Related Routines: Rotate, Resize




B/W Gray Color

Source

Destination

Negative

Syntax: Negative.exe
< Source File or Directory >
< Destination File or Directory >

Purpose: This routine creates the negative of Source image(s). In B/W images, black pixels are
made white and white pixels are made black. In gray images the pixel color is 255 minus the
current pixel color. Similarly, for colour images each of the Red, Green, and Blue components of
the color pixel become 255 minus the original color component value.

Uses: This routine can be used to create visual effects in images. Can also be used with logical
routines (ImgXOR, ImgOR, and ImgAND) to remove aspects from the original image.

Related Routines: Chgbits, ChgColor




B/W Gray Color

Source

Destination

PadIlmg

Syntax: Padlmg.exe

< Source File or Directory >

< Destination File or Directory >

< Amount of rows of white pixels to add to TOP Edge of Image >

< Amount of rows of white pixels to add to BOTTOM Edge of Image >
< Amount of columns of white pixels to add to LEFT Edge of Image >
< Amount of columns of white pixels to add to RIGHT Edge of Image >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >

Purpose: This routine adds white pixels to the margins of image(s).
Uses: This routine can be used to increase margins of book page images.

Related Routines: Croplmg, Subimg, DelEdge




B/W Gray Color

Source

Destination

Resize

Syntax: Resize.exe

< Source File or Directory >

< Destination File or Directory >
< New Image Width >

<New Image Height >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >

Purpose: This routine scales the image(s) to a desired size (dimensions). The original DPI (dots
per inch) is preserved.

Uses: Can scale image(s) maintaining aspect ratio or by changing aspect ratio.

Related Routines: SetDPI




B/W Gray Color

Source

Destination

Rotate

Syntax: Rotate.exe
< Source File or Directory >
< Destination File or Directory >

< Angle of Rotation (in Degrees) > This value can be an integer or floating point number. A
positive value represents a clockwise rotation and a negative value represents a counter-
clockwise rotation.

Purpose: This routine rotates image(s) about the center of the image.

Uses: This can remove known skew in image(s) or to change the orientation of image(s) to one
of : 90, 180 or 270 degrees.

Related Routines: Shiftimg, SkewlmgX, SkewImgyY




B/W Gray Color

Source

Destination

SetDPI

Syntax: SetDPl.exe

< Source File or Directory >

< Destination File or Directory >
< X DPI (Dots Per Inch) >

<Y DPI (Dots Per Inch) >

Purpose: This routines sets the X and Y DPI values to set values for one or more images. The
dimensions of the images are not changed.

Uses: Some applications require that an X and Y DPI value be set in the image header but some
other applications do not set these values (set to a value of 0).

Related Routines: Resize




B/W Gray Color

Source

Destination

Shiftimg

Syntax: Shiftimg.exe

< Source File or Directory >

< Destination File or Directory >
< Shift X >

< Shift Y >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >This parameter
applies to the < Shift X > and < Shift Y > parameters.

Purpose: This routine shifts the image(s) to the left (if Shift X value is negative), to the right (if
Shift X value is positive), upwards (if Shift Y is negative) or downwards (if Shift Y is positive).

Uses: This routine can be used to shift the content of one or more images with respect to the
borders of the images.

Related Routines: Croplmg, Subimg




B/W Gray
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Destination

SkewImgX

Syntax: SkewlmgX.exe
< Source File or Directory >
< Destination File or Directory >

< X Shift > A positive X Shift value skews the top of the image toward the right relative to the
bottom of the image and a negative X Shift value skews the top of the image towards the left
relative to the bottom of the image. The height of the image does not change but the width of
the image increases by the absolute value of X Shift value.

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width > This parameter applies to
the < X Shift > parameter.

Purpose: This routine skews one or more images towards the right or left.

Uses: This routine can be used to try and remove skew from images or to create skew to give
the effect of italic characters for example.

Related Routines: SkewlmgY, Shiftimg




B/W Gray
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SkewImgY

Syntax: SkewImgY.exe
< Source File or Directory >
< Destination File or Directory >

<Y Shift > A positive Y Shift value skews the left side of the image towards the bottom relative
to the right side of the image and a negative Y Shift value skews the left side of the image
towards the top relative to the right side of the image. The width of the image does not change
but the height of the image increases by the absolute value of Y Shift value.

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Height > This parameter applies to
the <Y Shift > parameter.

Purpose: This routine skews one or more images towards the top or bottom.

Uses: This routine can be used to try and remove skew from images or to create skew to give
the effect of italic characters (oriented at 90 degrees) for example.

Related Routines: SkewlmgX, Shiftimg




B/W Gray Color

Source

Destination

SubImg

Syntax: Sublmg.exe

< Source File or Directory >

< Destination File or Directory >
< Min X Coordinate >

< MinY Coordinate >

< Max X Coordinate >

< Max Y Coordinate >

< Units 0=Pixels 1=Inches 2=Centimetres 3=Percentage of Width or Height >

Purpose: This routine takes a subimage of the Source image based on the coordinates provided.
The origin of the coordinate system (0,0) is located in the upper left corner of the image with
the lower right corner coordinate being (width-1, height-1).

Uses: This routine can be used to extract a given section of an image and save it as a new
image.

Related Routines: Croplmg, DelEdge, Padimg




B/W Gray Color

Source

Destination

TransImg

Syntax: Transimg.exe
< Source File or Directory >

< Destination File or Directory >

Purpose: This routine will create a “Transposed” image where the coordinates of each pixel in
the image is transposed (x,y) = (y,x). The width of the Destination image is the height of the
Source image and similarly the height of the Destination image is the width of the Source image.

Uses: Various

Related Routines: Mirror




B/W Gray Color

Source

Destination

Whitelmg

Syntax: Whitelmg.exe

< Destination File >

< Width of Image >

< Height of Image >

< Units 0=Pixels 1=Inches 2=Centimetres >
< DPI (Dots Per Inch) >

< Number of Bits 1=B/W, 8=Grayscale, 24=Colour>

Purpose: This routine creates a white image of specified dimensions and attributes.

Uses: The blank white image created can be used as a background onto which other content
can be placed.

Related Routines: Blackimg, Colorimg




